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1 Introduction 

The Intel® System Event Log Viewer (SEL Viewer) can be used to display, clear, or save the SEL logon on a 

server.  

The SEL Viewer utility provides the ability to view system event records stored on the server management 

storage device of a server. The Baseboard Management Controller (BMC) records the details about the 

system events in a log in flash memory. Each SEL entry is a single system event. 

 Displays the SEL records in either a text or a hexadecimal format.  

 Allows saving SEL entries to a file.  

 Allows loading SEL entries from a server and displays their properties.  

The SEL Viewer utility is only supported on the following Intel® Server products: 

 Intel® Server Board based on Intel® Xeon® Scalable Processor Family 

 Intel® Server Board based on Intel® Xeon® 2nd Scalable Processor Family 

 Intel® Server Board based on Intel® Xeon® Platinum 9200 Processor Family 

 

For the latest information on a server, refer to http://support.intel.com/support/motherboards/server/. 

http://support.intel.com/support/motherboards/server/
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1.1 Operating System Supported 

This version of the SEL Viewer utility runs on the following operating systems (OS). 

Table 1. Operating systems supported 

Platforms Operating Systems/Preboot Environment Supported 

 Intel® Server Board based on Intel® Xeon® Scalable 

Processor Family 

 Intel® Server Board based on 2nd Generation Intel® Xeon® 

Scalable Processor family 

 Intel® Server Board based on Intel® Xeon® Platinum 9200 

Processor Family 

  

 UEFI Shell              

 WinPE* 4.0 (x64)        

 Windows* Server 2019    

 Windows* Server 2016    

 Windows* Server 2012 R2 

 Windows* 10             

 RHEL* 6.8 (x64)         

 RHEL* 7.3               

 RHEL* 7.5               

 RHEL* 7.6               

 SLES* 11.4 (x64)        

 SLES* 12.2              

 SLES* 15                

 CentOS* 7.3 (x64)       

 Debian* 8.10            

Note: The SEL Viewer Utility version may be different across different platforms. Download the supported 

SEL Viewer Utility version and build for a specific platform from Intel’s support website. Refer to release 

notes for known issues. 

1.2 Target Audience 

This User Guide is intended for Original Equipment Manufacturers and those who are responsible for 

configuring the system BIOS and Management Firmware settings on a Intel Server system. 

1.3 Support Information 

For more information, visit Intel’s support site at http://support.intel.com/support/. 

For an updated support contact list, see http://www.intel.com/support/9089.htm/. 

http://support.intel.com/support/
http://www.intel.com/support/9089.htm/
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2. Using the Intel® System Event Log Viewer Utility 

2.1 Installing the SEL Viewer 

SEL Viewer requires Windows* administrative or Linux* root permissions. 

 

To install the SEL Viewer Utility in EFI, do the following: 

1. Copy all the files in the SEL Viewer release directory for EFI to a USB flash drive, or create an EFI-

bootable CD. 

2. Insert the removable media into the server. 

3. Boot the server and press the <F2> key when prompted to enter BIOS setup. 

4. Go to the Boot Manager menu and select the option to boot to EFI shell. 

At the EFI shell prompt, type fsn: where n is the file system number corresponding to the device 

that contains the SEL Viewer utility files. 

To install the SEL Viewer Utility in Windows* with the standalone installation, do the following: 

Prerequisites: Java* Runtime Environment (JRE*) must be installed. 

1. Install JRE X64 version for supporting WinPE (x64) OS. Installation of JRE in a USB pen drive should 

be performed on the same version of the OS. 

Example: for the JRE x64 version use Windows 64-bit OS.  

2. In Windows/Windows PE set the JRE path using PATH=%PATH%;<>:\bin (where <> is the USB 

directory shown on the command prompt such as D: or E: or the path where java is installed (for 

example, c:\Program Files\Java). 

3. While installing JRE on USB pen drive to support Windows PE OS, change the installation directory 

USB pen drive (for example, g:\). 

4. Copy all files and subdirectories from the utility released location into a folder on the hard drive 

(for example, c:\Selview). 

5. Open a command prompt and change to that directory: 

6. For 32-bit Windows, go to folder c:\Selview\Windows\x86\imbdriver. 

7. For 64-bit Windows/Windows PE*, go to folder c:\Selview\Windows\x64\imbdriver. 

8. Execute install.cmd as administrator. 

9. This installation script installs the IPMI driver from Intel. If the IPMI driver from Microsoft* is present, 

the IPMI driver from Intel is not be installed on the system. 

10. To run the SEL Viewer Utility, open a command prompt, and change directory to the folder where the 

selview.exe file resides (for example, cd c:\Selview\windows\x64). 

The SEL Viewer Utility can now be run. 
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To install the SEL Viewer Utility in Linux*, perform the following steps. 

Prerequisites 

1. Java* Runtime Environment (JRE*) must be installed. 

2. XServer must be running for the SEL Viewer GUI to work. 

3. In Red Hat* OSes: 

o If the utility fails with the error message:  

"Error while loading shared libraries: libncurses.so.5: cannot open shared object file: No such 

file or directory" 

 then install libstdc++-xxx.rpm and ncurses-xxx.rpm from the OS CD itself using the following 

commands: 
#rpm -ivh libstdc++-xxx.rpm 

#rpm -ivh ncurses-xxx.rpm 

Example: 
rpm -ivh media\Packages\libstdc++-xxx.rpm 

o If the utility fails with error message:  

"Error: /lib/ld-linux.so.2: Bad ELF interpreter: No such file or directory". 

It indicates the development and optional packages are not installed. Install the necessary 

packages accordingly. 

4. On Red Hat Enterprise Linux, CentOS, UEFI aware Linux* or other Linux*: 

There might be a driver confliction between internal driver and kernel. Start up OpenIPMI driver and 

make sure the /dev/ipmi0 device exists. 

For example, use the below command to start up OpenIPMI driver on Red Hat Enterprise Linux. 

#modprobe ipmi_devintf 

a. Regular Installation: 

i. Boot into Linux and unzip the SELViewer utility ZIP file into a folder on the hard drive.  

ii. Copy all files and subdirectories from the utility released location into a folder on the hard 

drive (for example, /home/Selview/Linux). 

iii. Open a command prompt and change to the correct directory  

(for example, cd /home/Selview/Linux_x64). 

iv. Unzip selview.zip to get the executable. 

Use “chmod 755” to change executable and script. 

Type: ./selview” to run the SEL Viewer utility. 

 

b. RPM Installation: 

i. Boot into Linux and unzip the SEL Viewer utility ZIP file into a folder on the hard drive. 

ii. Copy rpm from Linux/RPM folder to a local folder. 

iii. If there is another version already has been installed previously, uninstall the older version 

before installing the new version. 

iv. Install the SEL Viewer utility by using rpm -ivh selviewer-xxx.rpm. This installs the 

utility in /usr/bin/selview/ folder. 

v. In Red Hat/SUSE after installing the rpm, close the terminal from which rpm was installed 

and then execute the utility from a new terminal (for example, # selview). 

vi. Type selview to run the SEL Viewer utility. 
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2.2 Launching the SEL Viewer 

To launch the SEL Viewer, do the following: 

1. Boot to the target OS.  

2. From the directory containing the SEL Viewer files, launch the SEL Viewer from the EFI shell using the 

following syntax: 

selview [/clear | {/save [filename] [/hex]} | /h | /?] 

Note: A hyphen (-) may be substituted for the forward slash (/). 

Examples: 

selview  

(This launches the graphical version of the SEL viewer.) 

selview /clear 

selview /save MyFileName /hex 

selview /h 

2.3 Viewing SEL Records in Interpreted Text Format 

1. Launch the SEL Viewer. 

2. All the SEL entries are displayed in the SEL Viewer. The text view is shown in Figure 1. 

 

Figure 1: SEL Viewer text view 

The EFI-based SEL Viewer main window is based on a multi-column display pane as shown in Figure 1. All 

the SEL records are displayed and a pull-down menu used for selecting the main functions available in the 

utility.  
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See Figure 2 for the SEL Viewer main utility window (Windows and Linux OSes). The default format in which 

information is displayed in interactive mode is the interpreted text format. 

 

Figure 2: SEL Viewer main window (Windows* and Linux* operating systems) 

The following interpreted data is displayed in several columns in Figure 2: 

 Serial No.: Serial number of the system events are displayed starting with 1, and increasing by one for 

each event. 

 Time Stamp 

 Sensor Type and Number 

 Event Description (Based on the IPMI Specification, BIOS EPS) 

 Generator ID 

The bottom information pane shows the details on the highlighted SEL entry. Use the arrow keys to move up 

and down, or the <Tab> key to highlight a menu. In Linux, the bottom information pane contains a statistics 

panel which holds a statistical table of events based on their Event Type (Critical, Warning, Informational, or 

Others). 

For information on using the menu items, see section 2.5.  
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2.4 Viewing SEL Records in Hex Format 

Highlight the View tab to choose how the SEL entries are displayed (raw hexadecimal format or plain text). 

Select the raw-hexadecimal format to view the SEL records in HEX format. 

Figure 3 shows an example of the SEL log in hex format. 

 

Figure 3: SEL log in hex format (EFI) 
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Figure 4 shows SEL records in Hex format (Windows and Linux OSes). 

 

Figure 4: SEL records in hex format (Linux*) 

The abbreviations used in the raw hex display are as shown in Table 1Table 2. 

Table 2. Acronyms used in the raw hex display 

Acronym Description 

RID Record ID 

RT Record Type 

TS Time Stamp 

GID Generator ID 

ER Event Message Format Revision 

ST Sensor Type 

SN Sensor Number 

EDIR Event Dir and Event Type 

ED1, ED2, ED3 Event Data 

MID Manufacturer ID 

OEM OEM Defined 

ExB1…ExB8 

Extended Byte1…Extended Byte8  

Note:  Supported only on:  

Intel® Server Board based on Intel® Xeon® processor E5-1600/2600/4600 v2 product family 

Intel Server Board based on Intel Xeon processor E5-2400 v2 product family 

Intel Server Board based on Intel Xeon processor E3-1200 v3/v4 product family 
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2.5 Viewing the SEL Viewer Information Window 

This option allows a user to view/hide the SEL Information window. When the utility is run, by default, the 

SEL Info window is visible and the sub-menu is shown as Hide SEL Info Window.  

If Hide SEL Info Window is selected, the SEL Info window is removed from the display area and the sub-

menu text changes to View SEL Info Window. Add the SEL Info window again using this sub-menu.  

Hide SEL Info Window / View SEL Info Window option is currently disabled in Hex view of EFI-based SEL 

Viewer utility. The SEL Info window automatically goes off when changing from text view to hex view. In case 

of Linux, this option is available under the SEL Menu. 
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2.6 Navigating the SEL Viewer Window 

To navigate the SEL Viewer window from the pull-down menu, use the arrow keys to move around the 

various menu items and the <Enter> key to select a particular menu item.  

A brief help message about the option selected from the menu is displayed in the tip-view window, which is 

displayed at the bottom of the main window for EFI-based SEL Viewer Utility. This feature is not supported 

by the Windows PE-based SEL Viewer Utility.  

 For the Windows PE-based SEL Viewer Utility 

o Use the <Alt> key to select the menu and use arrow keys to move around various menu items  

o Use the <Enter> key to select a particular menu item.  

o A menu item is also accessed by clicking the menu item. 

o In the display pane, use <Home> key selects the first record and <End> key selects the last 

record.  

Table 3 list the shortcut keys in the SEL Viewer. 

Table 3. Shortcut keys for Windows PE*-based SEL Viewer utility 

Utility Version Shortcut Keys Descriptions 

Windows PE* 

<Alt>+<F> Open File menu. 

<Alt>+<S> Open SEL menu. 

<Alt>+<V> Open View menu. 

 For the EFI-based SEL Viewer Utility: 

o Use <Tab> key to move between the display pane, information window at the bottom and 

pull-down menu. 

o The display pane supports arrow keys, <PgDn>, <PgUp>, <Home>, and <End> keys to move 

across the display pane. 

o Use <Home> key selects the beginning of the selected SEL entry in the display pane, and 

<End> key selects the end of the selected SEL entry in the display pane. 

o Use <F5> key to move forward between columns and <F6> to move backwards. 

o Use left arrow key to scroll to the left and right arrow key to scroll to right in display pane. 

When the utility is first invoked, it loads the SEL records from non-volatile storage on the server. 

Figure 5 shows the status of the SEL Viewer loading SEL records from the server. 

 

Figure 5: Status box 

 For Window/Linux-based SEL Viewer Utility 

o Serial Numbers can be color coded based on the severity of a SEL Event.  

o A small panel is provided on the bottom right corner which has a statistical view of the SEL 

Records. It contains the count of the SEL events segregated based on the severity type 

(i.e. Informational, Warning, Critical, or Others). 

o In Linux, the status message is displayed on the status bar of the Utility main window. 
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2.7 Saving the SEL Viewer records to a File 

At this point the user may want to save the SEL records to a file for analysis, record keeping, or 

documentation of a system issue. There are two ways to save the SEL to a file (the Windows PE version is 

shown in this example). To save the SEL, use the following command line syntax: 

 In interpreted text format:  

selview /save MyFileName  

 In hex format:  

selview /save MyFileName /hex 

 Use the File | Save menu option from the graphical SEL viewer window to save the SEL data to a file 

with a .sel file name extension, either in interpreted text format or in raw hex format, depending on 

the mode in which records are currently displayed. 

2.8 Viewing the SEL Viewer from a File 

To view the SEL records previously saved to a file, use the File | Open menu option from the graphical SEL 

viewer window. 

To return to viewing the SEL records from non-volatile memory, use the SEL | Reload menu option. 

  



Intel® System Event Log Viewer Utility User Guide 

16  

2.9 Checking the SEL Viewer Properties 

To check the SEL properties (number of entries, add/erase time, space available, and so on) in the SEL 

Properties dialog, use the SEL | Properties menu option from the SEL Properties Dialog as shown in Figure 6. 

 

Figure 6: SEL properties dialog 

Notes:  

 The SEL viewer displays the Free Space Remaining in bytes. 

 In Linux, the SEL Properties dialog does not display Last Add Time and Last Erase Time. 

2.10 Clearing the SEL Viewer Utility 

The SEL Viewer has a limited capacity. Refer to the Specifications in the Intel® Server Board product guide for 

the maximum number of records for server. After the SEL is full, subsequent system events are not be 

recorded and the SEL Viewer needs to be manually cleared. There are two ways to clear the SEL Viewer (the 

Windows PE version is shown in this example): 

 Use the command line syntax: selview /clear 

 Use the SEL | Clear menu option from the graphical SEL viewer window. 

2.11 Sorting the SEL Viewer Utility Entries in the User Interface 

Use the SEL | Sort by option in the SEL Viewer main window to sort the SEL entries by different fields.  

This option, when selected, displays a list of fields by which the entries can be sorted. Sort the records by 

Num, Time Stamp, Sensor Type and Number, Event Description, or Generator ID upon choosing the 

appropriate field.  

This option is not available if the SEL entries are displayed in hexadecimal mode.  

For the Windows/Linux based SEL Viewer utility, sorting can also be performed by clicking on the 

appropriate Column heading using a mouse (in case of text mode display). 

2.12 Go to Option (Windows*/Linux*-Feature Only) 

Use the SEL | Go To option in the SEL Viewer main window to select a particular SEL entry given its Serial 

Number. Enter the Serial Number of the SEL Entry in the textbox provided in the Go To dialog and the SEL 

Table on the Utility main window scrolls and that particular entry is highlighted. Go To can be accessed by 

the shortcut <CTRL>+<G>. This feature is currently supported only on Windows and Linux. 
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2.13 Getting Additional Help 

For help on the command line syntax or any of the graphical menu items that are not described in this User 

Guide, use the online help. There are two ways to get help: 

 Use the command line syntax: selview /help 

 Use the Help menu option from the graphical SEL Viewer window. 

2.14 Uninstalling the SEL Viewer Utility 

To uninstall the SEL Viewer Utility in EFI, do the following: 

1. Go to the directory in the command line prompt, where all the utility files are copied from the utility 

released location. 

2. Run cd .. on a command line prompt. This goes to one directory level below. 

3. Remove all the directories including subdirectories in the current directory. This leads to the 

uninstallation of the utility files. 

To uninstall the SEL Viewer Utility in Windows, do the following: 

The utility files should be manually removed, if they were installed stand alone. 

1. Go to the directory in the command line prompt, where all the utility files are copied from the utility 

released location. 

2. Run cd .. on a command line prompt. This goes to one directory level below. 

3. Remove all the directories including subdirectories in the current directory. This uninstalls the SEL 

Viewer utility files. 

To uninstall the SEL Viewer Utility in Linux, do the following: 

1. Go to the directory in the command line prompt, where all the utility files are copied from the utility 

released location. 

2. Run cd .. on a command line prompt. This goes to one directory level below 

3. Remove all the directories including subdirectories in the current directory. This uninstalls the SEL 

Viewer utility files. 
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Appendix A. Appendix Exit Error Codes 

The command line version of the Intel® System Event Log Viewer Utility (SEL Viewer) may be used in a script 

to automate the tasks of saving the SEL, clearing the SEL, or searching the SEL. 

The exit codes listed in Table 4 may be useful in the error handling section of the script. 

Table 4. Exit error codes 

Integer Value Interpretation 

0 Successful termination 

1 Unable to clear SEL 

2 SEL log is empty 

3 Unable to read SEL entries 

4 Unable to create SEL file 

5 Invalid invocation 

6 IPMI Driver initialization failed 

7 Unable to initialize SEL Viewer 

8 Unknown error 
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Appendix B. Glossary 

Term Definition 

BIOS Basic Input/Output System 

BMC Baseboard management controller 

EPS External Product Specification 

IPMI Intelligent Platform Management Interface 

JRE Java* Runtime Environment 

LAN Local area network 

RAM Random Access Memory 

SEL System event log 

 


